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Package Contents 

Minimum System Requirements 

Note: Using a power supply  with a different voltage than the one included with the 
DWL-7700AP will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

 Computers with Windows®, Macintosh, or Linux-based operating systems with 
an  installed Ethernet Adapter

 Internet Explorer version 6.0 or Netscape Navigator version 7.0 and above

Package Contents

 D-Link AirPremierTM DWL-7700AP 
 Wireless AG Outdoor AP/Bridge
 
 Eight screws & one rubber ring 

 Two rubber dipole antennas

 Manual on CD

 Quick Installation Guide

 2 Mounting Kits
 
 PoE base unit

 Power adapter

 Power cord

 RF jumper cable

 Grounding wire
 
 Surge arrestor 

 30m Ethernet cable
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Introduction 
Introduction

At up to fifteen times the speed* of previous wireless devices you can work faster and 
more efficiently, increasing productivity. With the DWL-7700AP, bandwidth-intensive 
applications like graphics or multimedia will benefit significantly because large files are 
able to move across the network quickly.

Inclusion of all three standards (802.11a; 802.11b; 802.11g) means that the 
DWL-7700AP is versatile enough to allow connection to almost any 802.11 network 
or device.

The DWL-7700AP is capable of operating in one of 3 different modes to meet your 
wireless networking needs. The DWL-7700AP can operate as an access point, or in 
WDS (Wireless Distribution System) with AP, or in WDS mode. 

Use less wiring, enjoy increased flexibility, save time and money with PoE (Power over 
Ethernet). With PoE, the DWL-7700AP shares power and data over the CAT5 cable, 
making the setup of your network less expensive and more convenient.

An ideal solution for quickly creating and extending a wireless local area network 
(WLAN) in offices or other workplaces, trade shows and special events, the DWL-7700AP 
provides data transfers at up to 54Mbps* when used with other D-Link Air Premier® 
or Air Premier AG® products (The 802.11g standard is backwards compatible with 
802.11b devices).

WPA is offered in two flavors: EAP (used for corporations), and PSK (used for home 
users).

WPA-PSK and WPA2-PSK is directed at home users who do not have the server based 
equipment required for user authentication. The method of authentication is similar to 
WEP because you define a “Pre-Shared Key” on the wireless router/AP. Once the pre-
shared key is confirmed and satisfied on both the client and access point, then access 
is granted. The encryption method used is referred to as the Temporal Key Integrity 
Protocol (TKIP), which offers per-packet dynamic hashing. It also includes an integrity 
checking feature which ensures that the packets were not tampered with during wireless 
transmission. WPA2-PSK is far superior to WPA-PSK, because the encryption of data 
is upgraded with the Advanced Encryption Standard (AES).

*Maximum wireless signal rate derived from IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary. 
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network 
overhead lower actual data throughput rate.
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Introduction (continued)

Introduction

WPA-EAP and WPA2-EAP is ideal for businesses that have existing security 
infrastructures in place. Management and security implementation can now be 
centralized on a server participating on the network. Utilizing 802.1x with a RADIUS 
(Remote Authentication Dial-in User Service) server, a network adminstrator can define 
a list of authorized users who can access the wireless LAN. When attempting to access 
a wireless LAN with either WPA-EAP or WPA2-EAP configured, the new client will 
be challenged with a username and password. If the new client is authorized by the 
administration, and enters the correct username and password, then access is granted. 
In a scenario where an employee leaves the company, the network administrator can 
remove the employee from the authorized list and not have to worry about the network 
being compromised by a former employee. WPA2-EAP is far superior to WPA-EAP, 
because the encryption of data is upgraded with the Advanced Encryption Standard 
(AES).

802.1x: Authentication which is a first line of defense against intrusion. In the 
authentication process, the Authentication Server verifies the identity of the client 
attempting to connect to the network. Unfamiliar clients would be denied access.

EAP (Extensible Authentication Protocol) is available through the Windows XP 
Operating System. You will need to use the same type of EAP protocol on all the devices 
in your network when using the 802.1x feature.
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Features and Benefits 
Features and Benefits

 3 Different Operation modes -  Capable of operating in one of three different 
operation modes to meet your wireless networking requirements: Access Point; 
WDS with AP; or WDS.

 Easy Installation with PoE (Power over Ethernet).

 Faster wireless networking speeds up to 54Mbps*.

 Compatible with 802.11a, 802.11b and 802.11g Devices that is fully compatible 
with the IEEE 802.11a, 802.11b and 802.11g standards, the DWL-7700AP can 
connect with existing 802.11b-, 802.11g- or 802.11a-compliant wireless network 
adapter cards. 

 Compatible with the 802.11b standard to provide a wireless data rate of up to 
11Mbps - that means you can migrate your system to the 802.11g standard on 
your own schedule without sacrificing connectivity.

 Better security with WPA - The DWL-7700AP can securely connect wireless clients 
on the network using WPA (Wi-Fi Protected Access) providing a much higher level 
of security for your data and communications than has previously been available.

 AP Manager Setup Wizard - The new Setup Wizard makes network configuration 
quick and simple.

 SNMP for Management - The DWL-7700AP is not just fast but it also supports 
SNMP v.3 for a better network management. Superior wireless AP manager 
software is bundled with the DWL-7700AP for network configuration and firmware 
upgrade. Systems administrators can also setup the DWL-7700AP easily with 
the   Web-based configuration. A D-Link D-View module will be downloadable 
for network administration and real-time network traffic monitoring with D-Link 
D-View software.

 Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing).

 Operates in the 2.437GHz frequency range for an 802.11a network, and in the 
5.26GHz frequency range for an 802.11b and 802.11g network.

 Web-based interface for managing and configuring.

*Maximum wireless signal rate derived from IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary. 
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network 
overhead lower actual data throughput rate.
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D-Link wireless products are based on industry standards to provide easy-to-use and 
compatible high-speed wireless connectivity within your home, business or public 
access wireless networks. D-Link wireless products will allow you to access the data you 
want, when and where you want it. You will be able to enjoy the freedom that wireless 
networking brings.

A Wireless Local Area Network (WLAN) is a computer network that transmits and 
receives data with radio signals instead of wires. WLANs are used increasingly in both 
home and office environments, and public areas such as airports, coffee shops and 
universities. Innovative ways to utilize WLAN technology are helping people to work 
and communicate more efficiently. Increased mobility and the absence of cabling and 
other fixed infrastructure have proven to be beneficial for many users. 

Wireless users can use the same applications they use on a wired network. Wireless 
adapter cards used on laptop and desktop systems support the same protocols as 
Ethernet adapter cards. 

People use WLAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location 
within the operating range of the WLAN. Management decisions based on real-time 
information can significantly improve worker efficiency.

Low Implementation Costs - WLANs are easy to set up, manage, change and relocate. 
Networks that frequently change can benefit from WLANs ease of implementation. 
WLANs can operate in locations where installation of wiring may be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and easy 
and can eliminate the need to pull cable through walls and ceilings. Wireless technology 
allows the network to go where wires cannot go - even outside the home or office.

Inexpensive Solution - Wireless network devices are as competitively priced as 
conventional Ethernet network devices. The DWL-7700AP saves money by providing 
multi-functionality, configurable in one of three different modes.

Scalability - WLANs can be configured in a variety of ways to meet the needs of 
specific applications and installations. Configurations are easily changed and range 
from Peer-to-Peer networks suitable for a small number of users to larger Infrastructure 
networks to accommodate hundreds or thousands of users, depending on the number 
of wireless devices deployed.

Wireless Basics 
Wireless Basics
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Wireless Basics (continued) 

Standards-based Technology

The DWL-7700AP Wireless Access Point utilizes the 802.11a, 802.11b and the 802.11g 
standards.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the 
maximum wireless signal rate of up to 54Mbps* within the 2.4GHz band, utilizing OFDM 
technology.

This means that in most environments, within the specified range of this device, you will 
be able to transfer large files quickly or even watch a movie in MPEG format over your 
network without noticeable delays. This technology works by transmitting high-speed 
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing) 
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals 
that are then transmitted simultaneously at different frequencies to the receiver. OFDM 
reduces the amount of crosstalk (interference) in signal transmissions. 

The D-Link DWL-7700AP will automatically sense the best possible connection speed 
to ensure the greatest speed and range possible.

The DWL-7700AP offers the most advanced network security features available today, 
including WPA and WPA2.  

In addition to its compatibility with 802.11g and 802.11a devices, the DWL-7700AP 
is compatible with 802.11b devices. This means that if you have an existing 802.11b 
network, or a network with a mixture of 802.11g, 802.11a and 802.11b, the devices in 
that network will be compatible with the DWL-7700AP.

*Maximum wireless signal rate derived from IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary. 
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network 
overhead lower actual data throughput rate.

Wireless Basics
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Wireless Basics (continued) 

The D-Link Air Premier® DWL-7700AP lets you access your network, using a wireless 
connection, from virtually anywhere within its operating range. Keep in mind, however, 
that the number, thickness and location of walls, ceilings, or other objects that the 
wireless signals must pass through, may limit the range. Typical ranges vary depending 
on the types of materials and background RF (radio frequency) noise in your home or 
business. The key to maximizing wireless range is to follow these basic guidelines:

Installation Considerations

1  Keep the number of walls and ceilings between the DWL-7700AP and other network 
devices  to a minimum - each wall or ceiling can reduce your DWL-7700AP’s range 
from 3-90 feet (1-30 meters.) Position your devices so that the number of walls or 
ceilings is minimized.

2 Be aware of the direct line between network devices. A wall that is 1.5 feet thick 
(.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter) thick. At a 
2-degree angle it looks over 42 feet (14 meters) thick! Position devices so that the 
signal will travel straight through a wall or ceiling (instead of at an angle) for better 
reception.

3 Building materials can impede the wireless signal - a solid metal door or aluminum  
studs may have a negative effect on range. Try to position wireless devices and 
computers with wireless adapters so that the signal passes through drywall or open 
doorways and not other materials.

4 Keep your product away (at least 3-6 feet or 1-2 meters) from electrical devices or 
appliances that generate RF noise.

Wireless Basics
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Three Operational Modes
Operational Modes
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1 You will need broadband Internet access.

2 Consult with your Cable or DSL provider for proper installation of the modem.

3 Connect the Cable or DSL modem to a Router. 
 (See the printed Quick Installation Guide included with your router.)

4 Connect the Ethernet Broadband Router to the PoE base unit. 
 (See the printed Quick Installation Guide included with the DWL-7700AP.)

5 Connect the DWL-7700AP to the PoE base unit. 
 (See the printed Quick Installation Guide included with the DWL-7700AP.)

6 If you are connecting a desktop computer to your network, install the D-Link    
DWL-AG530 wireless PCI adapter into an available PCI slot on your desktop 
computer.

 (See the printed Quick Installation Guide included with the DWL-AG530.)

7 Install the drivers for the D-Link DWL-AG660 wireless Cardbus adapter into a 
laptop computer. 

 (See the printed Quick Installation Guide included with the DWL-AG660.)

Getting Started
Getting Started
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Connecting PoE (Power over Ethernet)

Connect one end of an Ethernet cable (included with your package) to the 
LAN port on the DWL-7700AP and the other end of the Ethernet cable to 
the port labeled P+DATA OUT on the PoE base unit.

Connect another Ethernet cable from the P+DATA IN port on the PoE base 
unit to your router/switch or to a PC. 

Attach the power adapter to the connector on the PoE base unit. Attach the 
power cord to the power adapter and into an electrical outlet.    

Step 1

Step 2

Step 3

Getting Started (continued)

Getting Started
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Using the Configuration Menu 
Using the Configuration Menu

To configure the DWL-7700AP, use a computer which is connected to the DWL-7700AP 
with an Ethernet cable (see the Network Layout diagram).

First, disable the Access the Internet using a proxy server function. To disable this 
function, go to Control Panel > Internet Options > Connections > LAN Settings 
and uncheck the enable box.  

Start your web browser program (Internet Explorer, Netscape Navigator). 

Type the IP address and http port of the DWL-7700AP in the address field           
(http://192.168.0.50) and press Enter. Make sure that the IP addresses of the 
DWL-7700AP and your computer are in the same subnet.

After the connection is established, you will see the user identification window as 
shown. 
Note: If you have changed the default IP address assigned to the DWL-7700AP, make sure to enter 
the correct IP address. 







 Type admin in the User Name field

Leave the Password field blank

Click OK

Note: If you have changed the password, make sure to enter the correct password.
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Using the Configuration Menu

The Home > Wizard screen will appear. Please refer to the Quick Installation Guide for 
more information regarding the Setup Wizard.

These buttons appear on most of the configuration screens in this section. Please 
click on the appropriate button at the bottom of each screen after you have  made a 
configuration change.

Home > Wizard
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Using the Configuration Menu

Home > Wireless > Access Point 

Access Point is selected from the drop-down menu.

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

52 is the default channel for 802.11a (6 for 802.11g). All devices on 
the network must share the same channel. 

The radio frequency will vary depending on the wireless channel 
that is chosen. The frequency in channel 52 is 5.26GHz. 

Mode:

SSID:

SSID Broadcast:

Channel:

Radio Frequency:

Wireless Band: Select either 802.11a or 802.11g.
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Using the Configuration Menu

Home > Wireless > Access Point (continued) 

Select Enable or Disable. Enable this feature to auto-select the 
channel for best wireless performance.

Select Open System to communicate the key across the 
network.

Select Shared Key to limit communication to only those devices 
that share the same WEP settings.

Select Open System/Shared Key to allow either form of data 
encryption.

Select 802.1x to verify the identity of would-be clients in conjunction 
with a RADIUS server.

Select WPA-EAP to secure your network with the inclusion of a 
RADIUS server.

Select WPA-PSK to secure your network using a password and 
dynamic key changes (No RADIUS server required).

Select WPA2-EAP to secure your network with the inclusion of 
a RADIUS server and upgrade the encryption of data with the 
Advanced Encryption Standard (AES).

Select WPA2-PSK to secure your network using a password and 
dynamic key changes. No RADIUS server required and encryption 
of data is upgraded with the Advanced Encryption Standard 
(AES).

Select WPA-Auto-EAP to allow the client to either use WPA-EAP 
or WPA2-EAP.

Select WPA-Auto-EAP to allow the client to either use WPA-PSK 
or WPA2-PSK.

Auto Channel 
Scan:

Authentication:
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Using the Configuration Menu

Home > Wireless > Access Point (WEP) 

Select Disabled or Enabled. (Disabled is selected here).

Select HEX or ASCII.

Select 64-bit, 128-bit, or 152-bit.

Select the 1st through the 4th key to be the active key.

Input up to four keys for encryption. You will select one of these 
keys in the valid key field.

Encryption:

Key Type:

Key Size:

Valid Key:

First through Fourth 
keys:

* Hexadecimal digits consist of the numbers 0-9 and the letters A-F.
ASCII (American Standard Code for Information Interchange) is a code for representing English letters as numbers 0-127.
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Using the Configuration Menu

Home > Wireless > Access Point (802.1x) 

WEP is selected.

Select the interval during which the group key will be valid. 1800 
is the recommended value. A lower interval may reduce transfer 
data rate.

Enter the IP address of the Radius server.

Enter the Radius port.

Enter the Radius secret.

Cipher Type:

Group Key Update 
Interval:

 
Radius Server:

Radius Port:

Radius Secret:
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Using the Configuration Menu

Home > Wireless > Access Point (WPA-EAP/WPA2-EAP) 

When you select WPA-EAP, WPA2-EAP or WPA-Auto-EAP, 
you must select AES, AUTO, or TKIP from the pull-down menu.

Select the interval during which the group key will be valid. 1800 
is the recommended value. A lower interval may reduce transfer 
data rate.

Enter the IP address of the Radius server.

Enter the Radius port.

Enter the Radius secret.

Cipher Type:

Group Key Update 
Interval:

 
Radius Server:

Radius Port:

Radius Secret:
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When you select WPA-PSK, WPA2-PSK, or WPA-Auto-PSK, you must 
select AES, AUTO, or TKIP from the pull-down menu.

Select the interval during which the group key will be valid. The 
default value of 1800 is reommended.

Enter a passphrase. The passphrase is an alpha-numeric password 
between 8 and 63 characters long. The password can include symbols 
(!?*&_) and spaces. Make sure you enter this key exactly the same on all 
other wireless clients. 

Cipher Type:

Group Key Update 
Interval:

PassPhrase:

Home > Wireless > Access Point (WPA-PSK/WPA2-PSK)

Using the Configuration Menu
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Home > Wireless > WDS with AP

Using the Configuration Menu

In WDS with AP mode, the DWL-7700AP wirelessly connects multiple networks, while 
still functioning as a wireless AP.  WDS (Wireless Distribution System) allows access 
points to communicate with one another wirelessly in a standardized way. It can also 
simplify the network infrastructure by reducing the amount of cabling required. Basically 
the access points will act as a client and an access point at the same time.

Select either IEEE 802.11a or IEEE 802.11g 

WDS with AP is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Wireless Band:

Mode:

SSID:
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Home > Wireless > WDS with AP (Continued)

Using the Configuration Menu

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

52 is the default channel for IEEE 802.11a, and 6 is the default 
channel for IEEE 802.11g. All devices on the network must share 
the same channel. (Note: The wireless adapters will automatically 
scan and match the wireless setting.) 

This option is unavailable in WDS with AP mode.

Enter the MAC addresses of the APs in your network that will serve 
as bridges to wirelessly connect multiple networks.

Select Open System to communicate the key across the 
network.

Select Shared Key to limit communication to only those devices 
that share the same WEP settings.

Select Open System/Shared Key to allow either form of data 
encryption.

Select WPA-PSK to secure your network using a password and 
dynamic key changes (No RADIUS server required).

SSID Broadcast:

Channel:

Auto Channel 
Scan:

Remote AP MAC 
Address:

Authentication:

Note: WDS is not completely specified in WiFi or IEEE standards. Communication 
with other vendor´s access points is not guaranteed.
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Home > Wireless > WDS with AP (WEP)

Using the Configuration Menu

Select Disabled or Enabled. (Disabled is selected here).

Select HEX or ASCII.

Select 64-bit, 128-bit, or 152-bit.

Select the 1st through the 4th key to be the active key.

Input up to four keys for encryption. You will select one of these 
keys in the valid key field.

Encryption:

Key Type:

Key Size:

Valid Key:

First through Fourth 
keys:

* Hexadecimal digits consist of the numbers 0-9 and the letters A-F.
ASCII (American Standard Code for Information Interchange) is a code for representing English letters as numbers 0-127.
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Home > Wireless > WDS with AP (WPA-PSK)

Using the Configuration Menu

When you select WPA-PSK, WPA2-PSK, or WPA-Auto-PSK you must 
select AES, AUTO, or TKIP from the pull-down menu.

Select the interval during which the group key will be valid. The 
default value of 1800 is recommended.

Enter a passphrase. The passphrase is an alpha-numeric password 
between 8 and 63 characters long. The password can include symbols 
(!?*&_) and spaces. Make sure you enter this key exactly the same on all 
other wireless clients. 

Cipher Type:

Group Key Update 
Interval:

PassPhrase:
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Home > Wireless > WDS

Using the Configuration Menu

In WDS, the DWL-7700AP wirelessly connects multiple networks, without functioning 
as a wireless AP.

Select either IEEE 802.11a or IEEE 802.11g 

WDS is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Wireless Band:

Mode:

SSID:
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Home > Wireless > WDS (continued)

Using the Configuration Menu

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

52 is the default channel for IEEE 802.11a, and 6 is the default 
channel for IEEE 802.11g. All devices on the network must share 
the same channel. 

This option is unavailable in WDS mode.

Enter the MAC addresses of the APs in your network that will serve 
as bridges to wirelessly connect multiple networks.

Select Open System to communicate the key across the 
network.

Select Shared Key to limit communication to only those devices 
that share the same WEP settings.

Select Open System/Shared Key to allow either form of data 
encryption.

Select WPA-PSK to secure your network using a password and 
dynamic key changes. (No RADIUS server required).

SSID Broadcast:

Channel:

Auto Channel 
Scan:

Remote AP MAC 
Address:

Authentication:
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Home > Wireless > WDS > Open System and/or Shared Key

Select Disabled or Enabled. (Disabled is selected here).

Select HEX or ASCII.

Select 64-bit, 128-bit, or 152-bit.

Select the 1st through the 4th key to be the active key.

Input up to four keys for encryption. You will select one of these keys 
in the valid key field.

Encryption:

Key Type:

Key Size:

Valid Key:

First through 
Fourth keys:

* Hexadecimal digits consist of the numbers 0-9 and the letters A-F.
ASCII (American Standard Code for Information Interchange) is a code for representing English letters as numbers 0-127.

Home > Wireless > WDS (WEP)

Using the Configuration Menu
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Home > Wireless > WDS (WPA-PSK)

Using the Configuration Menu

When you select WPA-PSK, you must select AES, AUTO, or TKIP 
from the pull-down menu.

Select the interval during which the group key will be valid. The 
default value of 1800 is reommended.

When you select WPA-PSK, please enter a PassPhrase in the 
corresponding field.

Cipher Type:

Group Key Update 
Interval:

PassPhrase:



30

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Access Point

WDS with AP

WDS

Open System
Shared Key
Open System/Shared Key
802.1x
WPA-EAP
WPA-PSK
WPA2-EAP
WPA2-PSK
WPA-Auto-EAP
WPA-Auto-PSK

Open System
Shared Key
Open System/Shared Key
WPA-PSK

Open System
Shared Key
Open System/Shared Key
WPA-PSK

AP Mode Authentication Available

Home > Wireless Modes

Using the Configuration Menu
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Home > LAN > Static

Static (Manual) is chosen here. Choose this option if you do not have 
a DHCP server in your network, or if you wish to assign a static IP 
address to the DWL-7700AP.

The default IP address is 192.168.0.50. Assign a static IP address 
that is within the IP address range of your network.

Enter the subnet mask. All devices in the network must share the 
same subnet mask..

Enter the IP address of the gateway in your network. If there isn’t 
a gateway in your network, please enter an IP address within the 
range of your network.

Using the Configuration Menu

Get IP From:

IP Address:

Subnet Mask:

Default Gateway:

 

LAN is short for Local Area Network. This is considered your internal network. These 
are the IP settings of the LAN interface for the DWL-7700AP. These settings may be 
referred to as private settings. You may change the LAN IP address if needed. The LAN 
IP address is private to your internal network and cannot be seen on the Internet.
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Get IP From:

IP Address:

Subnet Mask:

Default Gateway:

 

Home > LAN > Dynamic

Using the Configuration Menu

Dynamic (DHCP) is chosen here. Choose Dynamic IP Address to 
obtain an IP Address automatically from a DHCP server in your 
network. 

This field is unavailable when DHCP is chosen.

This field is unavailable when DHCP is chosen.

This field is unavailable when DHCP is chosen.
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Using the Configuration Menu

Advanced > Performance

Wireless Band:

Frequency:

Channel:

Data Rate:

Beacon Interval:

Select IEEE 802.11a or IEEE802.11g.

The frequency reflects the choice of the wireless band. When IEEE 
802.11a is chosen the frequency is 5.26GHz for channel 52. When 
IEEE 802.11g is chosen the frequency is 2.437GHz for channel 6.

The default channel for IEEE 802.11a is 52, and the default channel 
for IEEE 802.11g is 6.

The Data Rates are Auto, 1Mbps, 2Mbps, 5.5Mbps, 6Mbps, 9Mbps, 
11Mbps, 12Mbps, 18Mbps, 24Mbps, 36Mbps, 48Mbps, 54Mbps.

Beacons are packets sent by an access point to synchronize a 
network. Specify a beacon interval value. The default (100) is 
recommended.
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Using the Configuration Menu

DTIM:

Fragment Length:

RTS Length:

Transmit Power:

(Delivery Traffic Indication Message) - Select a setting between 1 
and 255. 1 is the default setting. DTIM is a countdown informing 
clients of the next window for listening to broadcast and multicast 
messages.

The fragmentation threshold, which is specified in bytes, determines 
whether packets will be fragmented. Packets exceeding the 2346 
byte setting will be fragmented before transmission. 2346 is the 
default setting 

This value should remain at its default setting of 2346. If you 
encounter inconsistent data flow, only minor modifications to the 
value range between 256 and 2346 are recommended

Choose full, half (-3dB), quarter (-6dB), eighth (-9dB), minimum 
power.

*Maximum wireless signal rate derived from IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary. 
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network 
overhead lower actual data throughput rate.

Radio:

Short Preamble:

Select ON or OFF.
 
Check to enable short preamble. Uncheck to use a long preamble.



35

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the Configuration Menu

Wireless Band:

Access Control:

MAC Address:

MAC Address List:

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is chosen 

Enter the MAC addresses that you wish to include in your filters list, 
and click Save.

When you enter a MAC address, it appears in this list. Click Delete 
next to a MAC address to remove it from the list.

Advanced > Filters > Wireless Access Settings

Select Disabled to disable the filters function.
Select Accept to accept only those devices with MAC addresses in 
the Access Control List.
Select Reject to reject the devices with MAC addresses in the 
Access Control List.
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Using the Configuration Menu

Advanced > Filters > WLAN Partition

Wireless Band: 

Internal Station 
Connection:

Ethernet to WLAN 
Access:

Connection 
Enabled:

Select IEEE802.11a or IEEE802.11g. 

Enabling this feature allows wireless clients to communicate with 
each other. If this is disabled, wireless stations of the selected band 
are not allowed to exchange data through the access point.

Enabling this feature allows Ethernet devices to communicate with 
wireless clients. If this is disabled, all data from the Ethernet to 
associated wireless devices is blocked. Wireless devices can still 
send data to the Ethernet.

Enabling this feature allows IEEE802.11a wireless clients to 
communicate with IEEE802.11g wireless clients. 
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Using the Configuration Menu

Advanced > Grouping

Load Balance: Select Enabled or Disabled. When you Enable Load Balance you 
allow several DWL-7700APs to balance wireless network traffic and 
wireless clients among the DWL-7700APs in the network. 

User Limit (0-64):

Link Integrate:

Ethernet Link 
Status:

Set the User Limit in this field (0-64).

Select Enabled or Disabled. (When Link Integrate is Enabled, 
and the Ethernet connection between the LAN and the AP is 
disconnected, the wireless segment associated with the AP will also 
be disconnected from the AP.)

This field displays the Ethernet Link Status. Link Up indicates that 
there is an Ethernet LAN connection to the AP. 
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DHCP Server 
Control:

IP Assigned From:

Using the Configuration Menu

Dynamic Host Configuration Protocol assigns dynamic IP 
addresses to devices on the network. This protocol simplifies 
network management and allows new wireless devices to receive 
IP addresses automatically without the need to manually assign 
new IP addresses.
Select Enable to allow the DWL-7700AP to function as a DHCP 
server.

Advanced > DHCP Server > Dynamic Pool Settings

Input the first IP address available for assignment in your network.
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Using the Configuration Menu

The Range of Pool 
(1-255):

SubMask:

Gateway:

Wins:

DNS:

Domain Name:

Lease Time 
(60-31536000 

sec.):

Status:

Enter the number of IP addresses available for assignment.

All devices in the network must have the same subnet mask to 
communicate. Enter the submask for the network here.

Enter the IP address of the gateway on the network.

Windows Internet Naming Service is a system that determines the 
IP address of a network computer that has a dynamically assigned 
IP address.

Enter the IP address of the DNS server. The DNS (Domain Name 
Server) translates domain names such as www.dlink.com into IP 
addresses.

Enter the domain name of the DWL-7700AP, if applicable. (An 
example of a domain name is: www.dlink.com.)

The Lease Time is the period of time before the DHCP server will 
assign new IP addresses.

Turn the Dynamic Pool Settings ON or OFF here.

Advanced > DHCP Server > Dynamic Pool Settings (continued)
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Using the Configuration Menu

Advanced > DHCP Server > Static Pool Settings

DHCP Server 
Control:

Assigned IP:

Assigned MAC 
Address:

SubMask:

Gateway:
 

Dynamic Host Configuration Protocol assigns IP addresses to 
wireless devices on the network. This protocol simplifies network 
management and allows new wireless devices to receive IP 
addresses automatically without the need to manually assign IP 
addresses.
Select Enable to allow the DWL-7700AP to function as a DHCP 
server. 

Use the Static Pool Settings to assign the same IP address to a 
device at every restart. The IP addresses assigned in the Static Pool  
list must NOT be in the same IP range as the Dynamic Pool. After you 
have assigned a static IP address to a device via its MAC address, 
click Apply; the device will appear in the Assigned Static Pool at 
the bottom of the screen. Edit or delete the device in this list.

Enter the MAC address of the device here.

Enter the subnet mask here.

Enter the IP address of the gateway on the network.
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Wins:

DNS:

Domain Name:

Status:

 

Windows Internet Naming Service is a system that determines 
the IP address of a network computer with a dynamically assigned 
IP address, if applicable.

Enter the IP address of the Domain Name Server, if applicable. 
The DNS translates domain names such as www.dlink.com into IP 
addresses.

Enter the domain name of the DWL-7700AP, if applicable.

This option turns the Static Pool settings ON or OFF.

Using the Configuration Menu
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Advanced > DHCP Server > Current IP Mapping List

These are IP address pools to which the DHCP server function has 
assigned dynamic IP addresses. 

This screen displays information about the current DHCP dynamic and static IP 
address pools. This information is available when you enable the DHCP function of the                   
DWL-7700AP and assign dynamic and static IP address pools.

Current DHCP 
Dynamic Pools:

Binding MAC 
address:

 
Assigned IP 

address: 

Lease Time:

The MAC address of a device on the network that is within the 
DHCP dynamic IP address pool.
 
The current corresponding DHCP-assigned dynamic IP address 
of the device.

The length of time that the dynamic IP address will be valid.
 
These are IP address pools to which the DHCP server function has 
assigned static IP addresses. 

The MAC address of a device on the network that is within the 
DHCP static IP address pool.

The current corresponding DHCP-assigned static IP address of 
the device.

Current DHCP 
Static Pools:

Binding MAC 
address:

Assigned IP 
address:

Using the Configuration Menu
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Using the Configuration Menu

Advanced > Multi-SSID

If you want to configure the Guest and Internal networks on Virtual LAN (VLANs), the 
switch and DHCP server you are using must suppport VLANs. As a prerequisite step, 
configure a port on the switch for handling VLAN tagged packets as described in the 
IEEE802.1Q standard.
(Please see the following page for more information.)
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Using the Configuration Menu

Advanced > Multi-SSID (continued)

Master SSID:

Guest SSID:

Security:

Key Type:

Key Size:

Key:

VLAN Group ID:

The Master SSID and Security can not be changed here. Those  
values follow the settings in Home>Wireless.

When you Enable Guest SSID you can name each guest SSID. 

The Security options for these three Guest SSIDs are Open System 
or Shared Key.
 
Select HEX or ASCII.
 
Select 64, 128, or 152-bits

Select the 1st through the 4th key to be the active key. Enter key 
here.

If you configure enable Guest access and configure Internal and 
Guest networks on VLANs, this field will be enabled.

Provide a number between 1 and 4094 for the Internal VLAN.

This will cause the access point to send DHCP requests with the 
VLAN tag. The switch and the DHCP server must support VLAN 
IEEE802.1Q frames. The access point must be able to reach the 
DHCP server.

Check with the Administrator regarding the VLAN and DHCP 
configurations.

Note: Security Setting Limit:
When the Primary SSID is set to use one key index for WEP, you can use 3 other key 
indexes for Guest SSIDs.

If the Primary SSID is set to 802.1x, WPA/WPA2-EAP, WPA/WPA2-PSK, WPA-Auto-EAP, 
or WPA-Auto-PSK, you can only use No Security for guest SSIDs.
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Using the Configuration Menu

Advanced > System Log

Log Server/IP 
Address:

Log Type:

View Log:

Enter the IP address of the log server.

Check the box for the type of activity you want to log. There are 
three types: System, Wireless, and Notice.

Click on View Log to view the recent log.

The log information will include, but not limited to, the following items:

 • Firmware upgrade
 • Client association with AP
 • Web Login
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Using the Configuration Menu

Tools > Admin

User Name:

Old Password:

New Password:

Confirm New 
Password:

 

Enter a user name. The default setting is admin.

To change your password, enter the old password here.

Enter your new password here.

Enter your new password again.
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Using the Configuration Menu

Tools > System

Apply Settings and 
Restart:

Restore to Factory 
Default Settings:

 

Click Restart to apply the system settings and restart the 
DWL-7700AP.

Click Restore to return the DWL-7700AP to its factory default 
settings..
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Update File: After you have downloaded the most recent version of the firmware 
from http://support.dlink.com to your hard drive, you can Browse 
your hard drive to locate the downloaded file. Select the file and click 
OK  to update the firmware.

Using the Configuration Menu

Tools > Firmware
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Update File:

Load Settings to the 
Loacl Hard Drive:

Browse for the configuration settings that you have saved to your 
hard drive. Click OK after you have selected the settings file.

Click OK to save the selected settings to your hard drive.

Using the Configuration Menu

Tools > Cfg File
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Tools > Cfg File > Choose file 

When you click Browse in the previous screen, the dialog box shown above appears.
Select the file you wish to download and click Open. 

When this dialog box appears, click Save and select a location to save the configuration 
file. 

Using the Configuration Menu
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Tools > Misc

Using the Configuration Menu

Status:

Timeout:

SNMP:

Telnet is enabled by default. Telnet is a program that allows you to 
control your network from a single PC.

Select a time period after which a session timeout will occur.

Check Enabled to use SNMP. SNMP is disabled by default.
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Status > Device Info

Using the Configuration Menu

Device 
Information:

This window displays the settings of the DWL-7700AP, the firmware 
version and the MAC address.
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Status > Stats

Using the Configuration Menu

WLAN 802.11A 
Traffic Statistics:

Choose WLAN 802.11A Traffic Statistics, or choose WLAN 
802.11G Traffic Statistics. WLAN 802.11A is chosen here. 
This window displays the statistics of the IEEE802.11a or 
IEEE802.11g network, depending upon your selection.
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Status > Indication

Using the Configuration Menu

Temperature 
Indication: This window displays the current operating temperature.
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Status > Client Info

Using the Configuration Menu

 
Client 

Information:
Select this option to obtain information on IEEE802.11a clients. 
Select WLAN 802.11G Client Information to obtain  information 
on  IEEE802.11g clients. A client is a device on the network that is 
communicating with the DWL-7700AP.

The following information is available for each client that is communicating with the 
DWL-7700AP.

MAC:

Band:

Authentication:

RSSI:

Power Saving 
Mode:

Displays the MAC address of the client.

Displays the wireless band, 802.11a or 802.11g.

Displays the type of authentication that is enabled.

Receive Signal Strength Indicator indicates the strength of the 
signal

Displays the status of the power saving feature.
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Help

Using the Configuration Menu

Click on any item in the Help screen for more information.Help:
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Using the AP Manager

Using the AP Manager
The AP Manager is a convenient tool to manage the configuration of your network from a 
central computer. With AP Manager there is no need to configure devices individually.

To launch the AP Manager: 
 • Go to the Start Menu
 • Select Programs
 • Select D-Link AirPremier AP Manager
 • Select DWL-7700AP
 

Click on this button to discover the devices available on the network.

Discovering Devices
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Using the AP Manager

Selecting Devices
The AP Manager allows you to configure multiple devices all at once. To select a single 
device, simply click on the device you want to select. To select multiple devices, hold 
down the Ctrl key while clicking on each additional device. To select an entire list, hold 
the Shift key, click on the first AP on the list and then click on the last AP on the list. 

IP Configuration

You can assign an IP address to an AP or assign IP addresses to multiple 
AP’s by clicking on this button after selecting the device(s).

Select the AP that you want to assign an IP address to and click the IP button. Enter 
the IP address and IP netmask for the selected device and click OK. 

You can configure multiple AP’s with IP addresses all at once. Click on the IP button 
after you’ve selected all of the AP’s you want to assign an IP address. Enter the IP 
address you want to assign the first unit and the AP manager will automatically assign 
sequential IP addresses. 



59

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the AP Manager

Device Configuration

Click on this button to access the configuration 
properties of the selected device(s).

The device configuration window allows you to configure settings but does not actually 
apply the settings to the device unless you click the Apply button. You can also save 
and load configuration files from this window. When you load a configuration file, you 
must click Apply if you want the settings to be applied to the selected device(s).

The save button allows you to save a configuration file of the selected 
device settings. Only settings that have a checkmark next to them 
are saved. You cannot save a configuration file if you selected more 
than one device in the device list. 

The Exit button will close the device configuration window. Any 
settings that haven’t been applied will be lost.

The open button is used to load a previously saved configuration file. 
After opening a configuration file, you must click the Apply button to 
save the settings to the selected device(s).

To save settings to the device, you must click the Apply button. Only 
settings that have a checkmark next to them will be applied.

Refresh will revert to the actual device settings of the selected 
device(s).

The Clear Checks button deselects all configurable options. This 
feature is useful if you only want to change a few settings. Deselect 
all items and only check the items that you want to modify. 

The Check All button will select all configurable options. Any setting 
that has a checkmark next to it is applied to the device or saved to 
the configuration file.

You can configure a single device by highlighting one device in the list, or you can 
configure multiple devices by highlighting multiple devices before clicking on the Device 
Configuration icon pictured above. The examples in this section show single device 
configuration. When you select multiple devices for configuration the procedure will be 
similar.
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Using the AP Manager

When selecting multiple devices for configuration, some options are 
unavailable for configuration by default as noted(*) below:

This allows you to change the device name for the selected 
access point. You must place a checkmark in the Device Name 
box to change the name. This option should only be configured 
when one access point is selected for configuration. 

If you’ve selected one device for configuration and you want 
to change the IP address of the device, check the IP Address 
box. You ca then enter an IP address and Subnet Mask for the 
selected access point. This option should only be configurable 
when one access point is selected for configuration. To configure 
multiple devices with an IP address at one time, please reference 
the previous page. 

 Enter the IP address of your gateway, typically your router 
address.

 

 

Device Configuration > General

Device Name(*): 

IP address and 
Subnet Mask(*):

Gateway:
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Using the AP Manager

Device Configuration > General (continued)

  User Limit:

This pulldown selection enables or disables Link Integrity. When 
Link Integrity is enabled, the wireless segment associated with the 
AP will be disconnected whenever the connection between the AP 
and the LAN is dropped.

This pulldown selection enables or disables the ability to Telnet into  
the selected device(s).

This pulldown selection defines the timeout period during a Telnet 
session with the selected device(s).

This pulldown selection enabled or disabled the ability to use SNMP 
to manage the access point. This option is disabled by default.

This pulldown selection enables or disables load balancing. When 
you enable load balance you allow several access points to balance 
wireless network traffic and wireless clients among the access points 
with the same SSID. All the APs that share Load Balancing must 
have the same SSID. Assign each access point a different non-
overlapping channel (e.g., 1, 6, 11).

DHCP client: There is a pulldown menu to select enabled or disabled. When 
enabled, the selected device(s) will function as a DHCP client(s). 
This allows them to receive IP configuration information from a DHCP 
server. When disabled, the access point(s) must have a static IP 
address assigned to them. 

Load Balance:

Enter the number of load balancing users, from 0-64.

Link Integrity:

Telnet Support: 

Telnet Timeout:

SNMP Setting 
Status:
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Device Configuration > Wireless > IEEE802.11a

SSID: The Service Set (network) Identifier of your wireless network. 

Channel:  Allows you to select a channel. 52 is the default setting. 

Radio Wave: Allows you to enable or disable the wireless (802.11a) signal from 
being transmitted.

Data Rate: A pulldown menu to select the maximum wireless signal rate for the 
selected devices(s).

A pulldown menu for selecting the transmit power of the selected 
device(s).

Tx Power:

Beacons are packets sent by an access point to synchronize a 
network. Specify the beacon value for the selected device(s) here. 
The default value of 100 is recommended.

Beacon Interval 
(20~1000):
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Device Configuration > Wireless > IEEE802.11a (continued)

Using the AP Manager

DTIM (1~255):

This sets the fragmentation threshold (specified in bytes). Packets 
exceeding the value set here will be fragmented. The default is 2346.

Fragment Length 
(256~2346): 

The RTS value should not be changed unless you encounter 
inconsistent data flow. The default value is 2346.

RTS Length 
(256~2346):

DTIM (Delivery Traffic Indication Message) is a countdown informing 
clients of the next listening window for broadcast and multicast 
messages.

* Maximum wireless signal rate derived from IEEE Standard 802.11a specifications. Actual data throughput 
will vary. Network conditions and environmental factors, including volume of network traffic, building 
materials and construction, and network overhead lower actual data throughput rate.

SSID Broadcast: Allows you to enable or disable the broadcasting of the SSID to 
network clients.

Autochannel Scan: Enable this option to allow the access point to automatically scan 
for an available channel.

Short Preamble: If you are transferring large amounts of data on your wireless 
network, enable this option.
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Using the AP Manager

Device Configuration > Wireless > IEEE802.11g

SSID: The Service Set (network) Identifier of your wireless network. 

Channel:  Allows you to select a channel. 6 is the default setting. 

Radio Wave: Allows you to enable or disable the wireless (802.11b/g) signal from 
being transmitted.

Data Rate: A pulldown menu to select the maximum wireless signal rate for the 
selected devices(s).

A pulldown menu for selecting the transmit power of the selected 
device(s).

Tx Power:

Beacons are packets sent by an access point to synchronize a 
network. Specify the beacon value for the selected device(s) here. 
The default value of 100 is recommended.

Beacon Interval 
(20~1000):
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Device Configuration > Wireless > IEEE802.11g (continued)

Using the AP Manager

DTIM (1~255):

This sets the fragmentation threshold (specified in bytes). Packets 
exceeding the value set here will be fragmented. The default is 2346.

Fragment Length 
(256~2346): 

The RTS value should not be changed unless you encounter 
inconsistent data flow. The default value is 2346.

RTS Length 
(256~2346):

DTIM (Delivery Traffic Indication Message) is a countdown informing 
clients of the next listening window for broadcast and multicast 
messages.

SSID Broadcast: Allows you to enable or disable the broadcasting of the SSID to 
network clients.

Autochannel Scan: Enable this option to allow the access point to automatically scan 
for an available channel.

Short Preamble: If you are transferring large amounts of data on your wireless 
network, enable this option.

* Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput 
will vary. Network conditions and environmental factors, including volume of network traffic, building 
materials and construction, and network overhead lower actual data throughput rate.
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Access Point

WDS with AP

WDS

Open System
Shared Key
Open System/Shared Key
802.1x
WPA-EAP
WPA-PSK
WPA2-EAP
WPA2-PSK
WPA-Auto-EAP
WPA-Auto-PSK

Open System
Shared Key
Open System/Shared Key
WPA-PSK

Open System
Shared Key
Open System/Shared Key
WPA-PSK

AP Mode Authentication Available

Device Configuration > Wireless > Authentication Modes
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Device Configuration > Security > 802.11a & 802.11g 

Using the AP Manager

The Security tab contains the WEP configuration settings on the intial page. If you select 
WPA as the authentication type, an additional tab will appear with the WPA configuration 
options based on your selection. 

The key is communicated across the network.Open:

Shared:

Open System/
Shared Key:

WPA:

WPA-PSK:

Limited to communication with devices that share the same 
WEP settings.

The key is communicated and identical WEP settings are 
required.

Used to authenticate clients via a RADIUS server.

Does not utilize a RADIUS server for authentication but 
uses a passphrase that is configured on the clients and 
access points.

Authentication 
Type:

Select from the pulldown menu the type of authentication to be used 
on the selected device(s).

 Key Values: 

Active Key Index:  Select which defined key is active on the selected device(s).

Select the key size (64-bit, 128-bit, or 152-bit) and key type (HEX or 
ASCII) and then enter a string to use as the key. The key length is 
automatically adjusted based on the settings you choose.

Encryption:  Enable or disable encryption on the selected device(s).

RADIUS:

Local User:

Built-in RADIUS server does not require outside server.

A type of 802.1x security that utilizes user login for security.
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Device Configuration > Security > WEP 

Using the AP Manager

The key is communicated across the network.Open:

Shared:

Open System/
Shared Key:

Limited to communication with devices that share the same 
WEP settings (recommended).

The key is communicated and identical WEP settings are 
required.

Authentication 
Type:

Select from the pulldown menu the type of authentication to be used 
on the selected device(s).

 Key Values: 

Active Key Index:  Select which defined key is active on the selected device(s).

Select the key size (64-bit, 128-bit, or 152-bit) and key type (HEX or 
ASCII) and then enter a string to use as the key. The key length is 
automatically adjusted based on the settings you choose.
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Device Configuration > Security > 802.1x

 
Select the interval during which the group key will be vaild. 1800 is the 
recommended setting. A lower interval may reduce transfer rates. 

Cipher Type: WEP only.

Group Key Update 
Interval:

Using the AP Manager
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Using the AP Manager

Device Configuration > Security > 802.1x (RADIUS)

Enter the port used on the RADIUS server. (1812 is default) 

RADIUS Server: Enter the IP address of the RADIUS server.

RADIUS Port:
 

Enter the RADIUS secret. RADIUS Secret:
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Using the AP Manager

Device Configuration > Security >  
WPA-EAP/WPA2-EAP/WPA-Auto-EAP

 
Select the interval during which the group key will be vaild. 1800 is the 
recommended setting. A lower interval may reduce transfer rates. 

Cipher Type: Select Auto, AES, or TKIP from the drop-down menu.

Group Key Update 
Interval:
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Using the AP Manager

Device Configuration > Security > WPA-EAP/WPA2-EAP/
WPA-Auto-EAP (Server)

Enter the port used on the RADIUS server. (1812 is default) 

RADIUS Server: Enter the IP address of the RADIUS server.

RADIUS Port:
 

Enter the RADIUS secret. RADIUS Secret:
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Using the AP Manager

Device Configuration > Security > WPA-PSK/WPA2-PSK/
WPA-Auto-EAP

 
Select the interval during which the group key will be valid. 1800 is the 
recommended setting. A lower interval may reduce transfer rates.

Cipher Type: Select Auto, AES, or TKIP from the drop-down menu.

Group Key Update 
Interval:

 
Enter a PassPhrase between 8-63 characters in length.PassPhrase:
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Using the AP Manager

Device Configuration > Filters

Enabling this allows wireless clients to communicate with each other. 
When this option is disabled, wireless stations are not allowed to 
exchange data through the access point.  

When disabled access control is not filtered based on the MAC 
address. If Accept or Reject is selected, then a box appears for 
entering MAC addresses. When Accept is selected, only devices 
with a MAC address in the list are granted access. When Reject 
is selected, devices in the list of MAC addresses are not granted 
access.  

Enabling this allows wireless IEEE802.11a and IEEE802.11g clients 
to communicate with each other. When this option is disabled, 
IEEE802.11a and IEEE802.11g wireless stations are not allowed 
to exchange data through the access point.  

The following features are configurable in IEEE802.11a & IEEE802.11g:

 Internal 
Station Connect 
Cross 11a, 11g: 

 Internal Station 
Connection: 

Broadcast from 
Ethernet to WLAN:

Enabling this option allows Ethernet devices to communicate with 
wireless clients. When this option is disabled, all data from Ethernet 
to wireless clients is blocked. Wireless devices can still send data to 
the Ethernet devices when this is disabled. 

 Access 
Control: 

Add or Delete MAC addresses in the Access Control List.
 Access 

Control List: 
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Using the AP Manager

Device Configuration > AP Mode

There are 3 AP modes that are configurable in IEEE802.11a & 
IEEE802.11g: 

 • Access Point
 • WDS with AP
 • WDS

Access Point, the default setting used to create a wireless LAN, is 
displayed here.
Please see the following pages for an explanation of the other 2 AP 
modes.

 Access Point: 
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Using the AP Manager

Device Configuration > AP Mode > WDS with AP

Allows you to connect multiple wireless LANs together wile acting 
as an access point as the same time. This only works with other 
DWL-7700APs. If enabled, you must enter the MAC address(es) of 
the other DWL-7700AP(s) on your network.

WDS with AP: 
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Using the AP Manager

Device Configuration > WDS

Allows you to connect multiple wireless LANs together. All other 
LANs must be using DWL-7700APs. When enabled, you must enter 
the MAC address of the other DWL-7700APs. Enter up to sixteen 
addresses.

 WDS: 
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 Enable or disable the DHCP server function. 

 Enter the initial IP address to be assigned by the DHCP server. 

Enter the number of allocated IP addresses.

 Enter the subnet mask.

Enter the gateway IP address, typically a router.

Wins (Windows Internet Naming Service) is a system that determines 
the IP address of a network computer with a dynamically assigned 
IP address, if applicable.

Click to enable Dynamic Pool Settings. Configure the IP address 
pool in the fields below. 

Click to enable Static Pool Settings. Use this function to assign the 
same IP address to a device at every restart. The IP addresses 
assigned in the Static Pool list must NOT be in the same IP range 
as the Dynamic Pool. 

DHCP Server:

Dynamic Pool 
Settings: 

Static Pool 
Settings: 

IP Assigned From:

Range of Pool (1~255): 

SubMask: 

Gateway: 

Wins: 

Using the AP Manager

Device Configuration > DHCP Server



79

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the AP Manager

Device Configuration > DHCP (continued)
  The IP address of the DNS server, if applicable.

  Enter the domain name of the DWL-7700AP, if applicable.

  The period of time that the client will retain the assigned IP address.

  This option turns the dynamic pool settings on or off.  

DNS:
Domain Name:

Lease Time:

Status:

Device Configuration > Monitor

  Displays the current operating temperature of the DWL-7700AP.Current Temp:
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Using the AP Manager

Device Configuration > Multi-SSID

If you want to configure the Guest and Internal networks on Virtual LAN (VLANs), the 
switch and DHCP server you are using must suppport VLANs. As a prerequisite step, 
configure a port on the switch for handling VLAN tagged packets as described in the 
IEEE802.1Q standard.

Master SSID:

Guest SSID:

Security:

The Master SSID and Security can not be changed here. Those  
values follow the settings in Home>Wireless.

When you Enable Guest SSID you can name each guest SSID. 

The Security options for these three Guest SSIDs are Open System 
or Shared Key.

Note: Security Setting Limit:
When the Primary SSID is set to use one key index for WEP, you can use 3 other key 
indexes for Guest SSIDs.

If the Primary SSID is set to 802.1x, WPA/WPA2-EAP, WPA/WPA2-PSK, WPA-Auto-EAP, 
or WPA-Auto-PSK, you can only use No Security for guest SSIDs.
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Device Configuration > MultiSSID

Using the AP Manager

Key Type:

Key Size:

Key:

VLAN Group ID:

Select HEX or ASCII.
 
Select 64, 128, or 152-bits

Select the 1st through the 4th key to be the active key. Enter key 
here.

If you configure enable Guest access and configure Internal and 
Guest networks on VLANs, this field will be enabled.

Provide a number between 1 and 4094 for the Internal VLAN.

This will cause the access point to send DHCP requests with the 
VLAN tag. The switch and the DHCP server must support VLAN 
IEEE802.1Q frames. The access point must be able to reach the 
DHCP server.

Check with the Administrator regarding the VLAN and DHCP 
configurations.
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Using the AP Manager

Device Configuration > Log

Remote Syslog 
Status:

Activity:

Server IP Address:

Check this box to enable logging.

Select to enable or disable from the drop-down menus. There are 3 
types: System, Wireless, and Notice. 

Enter the IP address of the Syslog server.
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Using the AP Manager

Device Configuration > Client-Info

 
Client 

Information:
Select this option to obtain information on IEEE802.11a clients. 
Select WLAN 802.11G Client Information to obtain  information 
on  IEEE802.11g clients. A client is a device on the network that is 
communicating with the DWL-7700AP.

The following information is available for each client that is communicating with the 
DWL-7700AP.

MAC:

Band:

Authentication:

RSSI:

Power Saving 
Mode:

Displays the MAC address of the client.

Displays the wireless band, 802.11a or 802.11g.

Displays the type of authentication that is enabled.

Receive Signal Strength Indicator indicates the strength of the 
signal

Displays the status of the power saving feature.



84

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the AP Manager

Configuration Files

The DWL-7700AP allows you to save the device settings to a configuration file. To save 
a configuration file follow these steps:
 
 Select a device from the Device List on the main screen of the AP Manager. 

 Click the device configuration button.

 Click the Save button after you have all the settings as you want them.

 A popup window will appear prompting you for a file name and location. Enter the 
file name, choose a file destination, and click Save. 

Device Configuration button.
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You must always click Apply 
in the Configuration window if 
you want the settings to take 
effect.

Using the AP Manager

To load a previously saved configuration file, follow these steps:
 
 Select a device from the Device List on the main screen of the AP Manager. 

  Click the device configuration button.

 Click the Open button.

 A popup window will appear prompting you to locate the configuration file. Locate 
the file and click Open. 

 The configuration file is loaded into the AP Manager but has not actually been 
written to the device(s). If you want to use the newly loaded configuration for the 
selected device(s), click Apply and the configuration settings will be written to the 
device(s).

Device Configuration button.
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Using the AP Manager

To upgrade the firmware:

  Download the latest firmware upgrade from http://support.dlink.com   
   to an easy to find location on your hard drive.

 Click on the firmware button as shown above.

 A popup window will appear. Locate the firmware upgrade file and    
 clickOpen.

You can upgrade the firmware by clicking on this button after 
selecting the device(s).

Firmware







IMPORTANT! DO NOT DISCONNECT POWER FROM THE UNIT WHILE THE 
FIRMWARE IS BEING UPGRADED.
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You can customize the basic System Settings for the 
DWL-7200AP by clicking on this button.

System Settings

Access Password: This sets the admin password for the select device(s).

Auto Refresh: This setting allows you to enable auto refreshing of the network     
device list. By default this option is disabled. If you choose to enable it, you must  
enter the refresh interval in seconds. All other settings on this screen should 
be left at the default setting.

Using the AP Manager
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Setup Wizard

This button will launch the Setup Wizard that will guide 
you through device configuration.

Click Next.

Using the AP Manager
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Setup Wizard (continued)

Enter a Password and retype it in the Verify Password field.

Using the AP Manager

Click Next.
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Setup Wizard (continued)

Enter the SSID and the 
Channel for the IEEE 
network.

Using the AP Manager

IEEE802.11a

Click Next.

If you want to enable 
Encryption, enter the 
Encryption values here.

Click Next.
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Setup Wizard (continued)

If you selected WEP, select 
the key size (64, 128, or 
152-bit), the key type (hex 
or ASCII), and then enter 
your WEP key.

Using the AP Manager

Click Next.

If you selected WPA-Personal 
(PSK), enter the passphrase.

Click Next.
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Setup Wizard (continued)

Using the AP Manager

IEEE802.11g

Enter the SSID and the Channel 
for the IEEE network. 

Click Next.

If you want to enable 
Encryption, enter the 
Encryption values here.

Click Next.
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Setup Wizard (continued)

Using the AP Manager

Click Next.

Click Next.

If you selected WEP, select 
the key size (64, 128, or 
152-bit), the key type (hex 
or ASCII), and then enter 
your WEP key.

If you selected WPA-Personal 
(PSK), enter the passphrase.
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Setup Wizard (continued)

Using the AP Manager

The DWL-7700AP setup is complete!
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Using the AP Manager

Refresh

Click on this button to refresh the list of 
devices available on the network.

Devices with a checkmark 
next to them are st i l l 
available on the network. 
Devices with an X are no 
longer available on the 
network.

Click on this button to view the 
version of AP Manager.

About
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Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using Microsoft 
Windows XP. 
 
Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about networking computers 
using Windows 2000, Me or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Networking Basics

When this screen appears, click Next.

Networking Basics
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Networking Basics

Click Next.

In the following window, select the best description of your computer. If your computer 
connects to the internet through a gateway/router, select the second option as 
shown.

Click Next.

Please follow all the instructions in this window:
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Networking Basics

Enter a Computer description and a Computer name (optional).

Click Next.

Enter a Workgroup name. All computers on your network should have the same 
Workgroup name.

Click Next.
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Please wait while the Network Setup Wizard applies the changes.

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer. This may take 
a few minutes.

Networking Basics



100

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Networking Basics

Insert a disk into the Floppy Disk Drive, in this case drive A.

Click Next.

In the window below, select the option that fits your needs. In this example, Create a 
Network Setup Disk has been selected.  You will run this disk on each of the computers 
on your network. Click Next.
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Please read the information under Here’s how in the screen below. After you complete 
the Network Setup Wizard you will use the Network Setup Disk to run the Network 
Setup Wizard once on each of the computers on your network. To continue click 
Next. 

Networking Basics
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Please read the information on this screen, then click Finish to complete the Network 
Setup Wizard.

The new settings will take effect when you restart the computer. Click Yes to restart 
the computer.

You have completed configuring this computer. Next, you will need to run the Network 
Setup Disk on all the other computers on your network. After running the Network 
Setup Disk on all your computers, your new wireless network will be ready to use.

Networking Basics
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Networking Basics

Naming Your Computer

To name your computer n Windows XP, please follow these directions.

 Click Start (in the lower left corner of the screen).

 Right-click on My Computer.

 Select Properties and click.

 Select the Computer Name Tab in the System Properties window.

 You may enter a Computer Description if you wish; this field is optional.

 To rename the computer and join a domain, Click Change.



104

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

 In this window, enter the Computer name.

 Select Workgroup and enter the name of the Workgroup.

 All computers on your network must have the same Workgroup name.

 Click OK.

Networking Basics

The wireless adapter-equipped computers in your network must be in the same IP 
Address range (see Getting Started in this manual for a definition of IP Address Range.)  
To check on the IP Address of the adapter, please do the following:

 Right-click on the Local Area Connection icon in the task bar.

 Click on Status.

Checking the IP Address in Windows XP
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Networking Basics

This window will appear:

 Click the Support tab.

 Click Close.
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Note: DHCP-enabled routers will automatically assign IP addresses to the computers 
on the network, using DHCP (Dynamic Host Configuration Protocol) technology. If you 
are using a DHCP-capable router you will not need to assign static IP addresses.

If you are not using a DHCP capable router, or you need to assign a static IP address, 
please follow these instructions:

 Go to Start.

 Double-click on Control Panel.

Assigning a Static IP Address in Windows 

Networking Basics

 Double-click on Network Connections.
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Networking Basics

 Right-click on Local Area Connections.

 Double-click on Properties.

 Click on Internet Protocol (TCP/IP).

 Click Properties.

 Input your IP address and subnet mask. (The IP addresses on your network 
must be within the same range. For example, if one computer has an IP address 
of 192.168.0.2, the other computers should have IP addresses that are sequential, 
like 192.168.0.3 and 192.168.0.4. The subnet mask must be the same for all the 
computers on the network.)
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 Input your DNS server addresses. (Note:  If you are entering a DNS server, you 
must enter the IP address of the default gateway.)

The DNS server information will be supplied by your ISP (Internet Service Provider.)

 Click OK.

Networking Basics

Assigning a Static IP Address in Macintosh OSX

 Go to the Apple Menu and select System Preferences.

 Click on Network.
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Networking Basics

 Select Built-in Ethernet in the Show pull-down menu.

 Select Manually in the Configure pull-down menu.

 Input the Static IP Address, the Subnet Mask and the Router IP Address in the 
appropriate fields.

 Click Apply Now.
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Networking Basics

 Go to the Apple Menu and select System Preferences.

 Click on Network.

 Select Built-in Ethernet in the Show pull-down menu.

 Select Using DHCP in the Configure pull-down menu.
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Networking Basics

 Click Apply Now.

 The IP Address, Subnet mask, and the Router’s IP Address will appear in a few 
seconds.

Go to Start > Run > type cmd.  A window similar to this one will appear. Type ping 
xxx.xxx.xxx.xxx, where xxx is the IP address of the wireless router or access point. 
A good wireless connection will show four replies from the wireless router or access 
point, as shown.

Checking the Wireless Connection by Pinging 
in Windows XP and 2000
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Troubleshooting

Troubleshooting
This Chapter provides solutions to problems that can occur during the installation and 
operation of the DWL-7700AP Wireless Access Point. We cover various aspects of the 
network setup, including the network adapters. Please read the following if you are 
having problems.

Note:  It is recommended that you use an Ethernet connection to configure the 
DWL-7700AP Wireless Access Point.

1. The computer used to configure the DWL-7700AP cannot access the  
Configuration menu.

 Check that the Ethernet LED on the DWL-7700AP is ON. If the LED is not ON, 
check that the cable for the Ethernet connection is securely inserted.

 Check that the Ethernet Adapter is working properly.  Please see item 3  (Check 
that the drivers for the network adapters are installed properly) in this 
Troubleshooting section to check that the drivers are loaded properly.

 Check that the IP address is in the same range and subnet as the DWL-7700AP.  
Please see Checking the IP Address in Windows XP in the Networking Basics 
section of this manual.

Note:  The IP address of the DWL-7700AP is 192.168.0.50. All the computers on the 
network must have a unique IP address in the same range, e.g., 192.168.0.x. Any 
computers that have identical IP addresses will not be visible on the network. They 
must all have the same subnet mask, e.g., 255.255.255.0.

 Do a Ping test to make sure that the DWL-7700AP is responding. Go to 
Start>Run>Type Command>Type ping 192.168.0.50.  A successful ping will show 
four replies.

Note: If you have changed the default IP address, make sure to ping the correct IP 
address assigned to the DWL-7700AP.
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Troubleshooting

2. The wireless client cannot access the Internet in the Infrastructure mode.

Make sure the wireless client is associated and joined with the correct access point. To 
check this connection:  Right-click on the Local Area Connection icon in the taskbar> 
select View Available Wireless Networks. The Connect to Wireless Network screen 
will appear. Please make sure you have selected the correct available network, as 
shown in the illustrations below.

 Check that the IP address assigned to the wireless adapter is within the same 
IP address range as the access point and gateway. Since the DWL-7700AP has 
an IP address of 192.168.0.50, wireless adapters must have an IP address in the 
same range, e.g., 192.168.0.x.  Each device must have a unique IP address; no two 
devices may have the same IP address. The subnet mask must be the same for all 
the computers on the network.) To check the IP address assigned to the wireless 
adapter, double-click on the Local Area Connection icon in the taskbar > select 
the Support tab and the IP address will be displayed. Please refer to Checking 
the IP Address in the Networking Basics section of this manual.)

 If it is necessary to assign a Static IP Address to the wireless adapter, please refer 
to the appropriate section in Networking Basics. If you are entering a DNS Server 
address you must also enter the Default Gateway Address. (Remember that if 
you have a DHCP-capable router, you will not need to assign a static IP address.  
See  Networking Basics: Assigning a Static IP Address.)



114

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

3.  Check that the drivers for the network adapters are installed properly.

You may be using different network adapters than those illustrated here, but this 
procedure will remain the same, regardless of the type of network adapters you are 
using.

 Go to Start > My Computer > Properties.

Troubleshooting

 Select the Hardware Tab.

 Click Device Manager.
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Troubleshooting

 Double-click on Network Adapters.

 Right-click on D-Link AirPlus DWL-G650 Wireless Cardbus Adapter. (In this 
example we use the DWL-G650; you may be using other network adapters, but the 
procedure will remain the same.) 

 Select Properties to check that the drivers are installed properly.

 Look under Device Status to check that the device is working properly.

 Click OK.
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Troubleshooting

4.  What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However, 
the positioning of the products within your environment will affect the wireless range.  
Please refer to Installation Considerations in the Wireless Basics section of this 
manual for further information about the most advantageous placement of your D-Link 
wireless products.

5.  Why does my wireless connection keep dropping?

 Antenna Orientation- Try different antenna orientations for the DWL-7700AP. Try to 
keep the antenna at least 6 inches away from the wall or other objects.

 If you are using 2.4GHz cordless phones, X-10 equipment or other home security 
systems, ceiling fans, and lights, your wireless connection will degrade dramatically 
or drop altogether. Try changing the channel on your router, access point and wireless 
adapter to a different channel to avoid interference.

 Keep your product away (at least 3-6 feet) from electrical devices that generate RF 
noise, like microwaves, monitors, electric motors, etc.

6.  Why can’t I get a wireless connection?

If you have enabled encryption on the DWL-7700AP, you must also enable encryption 
on all wireless clients in order to establish a wireless connection.

 Make sure that the SSID on the router and the wireless client are exactly the same.  
If they are not, wireless connection will not be established. 

 Move the DWL-7700AP and the wireless client into the same room and then test 
the wireless connection. 

 Disable all security settings. 

 Turn off your DWL-7700AP and the client. Turn the DWL-7700AP back on again, 
and then turn on the client. 

 Make sure that all devices are set to Infrastructure mode. 

 Check that the LED indicators are indicating normal activity. If not, check that the 
AC power and Ethernet cables are firmly connected.

 Check that the IP address, subnet mask, gateway and DNS settings are correctly 
entered for the network. 

 If you are using 2.4GHz cordless phones, X-10 equipment or other home security 
systems, ceiling fans, and lights, your wireless connection will degrade dramatically 
or drop altogether. Try changing the  channel on your DWL-7700AP, and on all the 
devices in your network to avoid interference.

 Keep your product away (at least 3-6 feet) from electrical devices that generate RF 
noise, like microwaves, monitors, electric motors, etc. 
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Technical Specifications

Technical Specifications 
Standards
• IEEE 802.11a
• IEEE 802.11b
• IEEE 802.11g
• IEEE 802.3
• IEEE 802.3u
• IEEE 802.3x

Device Management
• Web-Based – Internet Explorer v6 or later; Netscape Navigator v7 or later; or other Java-enabled 
browsers.
• Telnet
• AP Manager
• SNMP v.3

Data Rate
For 802.11a/g:
• 54, 48, 36, 24, 18, 12, 9 and 6Mbps
For 802.11b:
• 11, 5.5, 2, and 1Mbps

Security
• WPA-Personal
• WPA-Enterprise
• WPA2-Personal
• WPA2-Enterprise
• 64/128/152-bit WEP
• SSID Broadcast Disable
• MAC Address Access Control List

Wireless Frequency Range
• 2.4GHz to 2.4835GHz
• 5.15GHz to 5.35GHz and
• 5.725GHz to 5.825GHz

Wireless Operating Range*
802.11a/g (Full Power with 5dBi gain diversity dualband dipole antenna)
Indoors: 
• 98ft (30m) @ 54Mbps
• 112ft (34m) @ 48Mbps
• 128ft (39m) @ 36Mbps
• 154ft (47m) @ 24Mbps
• 184ft (56m) @ 18Mbps
• 217ft (66m) @ 12Mbps
• 259ft (79m) @ 9Mbps
• 325ft (99m) @ 6Mbps
Outdoors:
• 367ft (112m) @ 54Mbps
• 820ft (250m) @ 18Mbps
• 1640ft (500m) @ 6Mbps

Operating Voltage
• 48VDC +/- 10% for PoE
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Radio and Modulation Type
For 802.11b:
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps
For 802.11a/g:
OFDM:
• BPSK @ 6 and 9Mbps
• QPSK @ 12 and 18Mbps
• 16QAM @ 24 and 36Mbps
• 64QAM @ 48, 54 and 108Mbps
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps

Transmit Output Power
For 802.11a:
• 100mW (20dBm)
• 50mW (17dBm)
• 30mW (15dBm)
• 20mW (13dBm)
• 10mW (10dBm)
• 5mW (7dBm)
• 1mW (0dBm)
For 802.11b:
• 200mW (23dBm)
• 63mW (18dBm)
• 30mW (15dBm)
• 20mW (13dBm)
• 10mW (10dBm)
• 5mW (7dBm)
• 1mW (0dBm)
For 802.11g:
• 200mW (23dBm)
• 63mW (18dBm)
• 30mW (15dBm)
• 20mW (13dBm)
• 10mW (10dBm)
• 5mW (7dBm)
• 1mW (0dBm)

Receiver Sensitivity
For 802.11a:
• 6Mbps: -85dBm
• 9Mbps: -84dBm
• 12Mbps: -82dBm
• 18Mbps: -80dBm
• 24Mbps: -77dBm
• 36Mbps: -73dBm
• 48Mbps: -69dBm
• 54Mbps: -68dBm
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For 802.11b:
• 1Mbps: -94dBm
• 2Mbps: -91dBm
• 5.5Mbps: -89dBm
• 11Mbps: -85dBm
For 802.11g:
• 1Mbps: -95dBm
• 2Mbps: -91dBm
• 5.5Mbps: -89dBm
• 6Mbps: -90dBm
• 9Mbps: -84dBm
• 11Mbps: -88dBm
• 12Mbps: -82dBm
• 18Mbps: -80dBm
• 24Mbps: -77dBm
• 36Mbps: -73dBm
• 48Mbps: -72dBm
• 54Mbps: -72dBm

Current Consumption
• Max.8.5W with PoE (without heater)
• Max.28.5W without PoE (with heater)

LEDs
• Power
• LAN
• 802.11a
• 802.11b/g

Temperature
• Operating: -40ºF to 140ºF (-40ºC to 60ºC)
• Storing: -40ºF to 149ºF (-40ºC to 65ºC)

Humidity
• Operating: 10%~90% (non-condensing)
• Storing: 5%~95% (non-condensing)

Certifications
• FCC Part 15
• CSA
• UL

Dimensions
• L = 10.93 inches (277.7mm)
• W = 6.10 inches (155mm)
• H = 1.77 inches (45mm)

Warranty
• 1 Year

* Environmental Factors may Adversely Affect Wireless Range

Technical Specifications
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Contacting Technical Support

You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within 
Canada for the duration of the warranty period on this product.  

U.S. and Canadian customers can contact D-Link technical support through our web 
site, or by phone. 
 
Tech Support for customers within the United States:

 D-Link Technical Support over the Telephone:
 (877) 453-5465
 Monday through Friday 8:00am to 5:00pm PST
 D-Link Technical Support over the Internet:
 http://support.dlink.com
 email:support@dlink.com

Tech Support for customers within Canada:

 D-Link Technical Support over the Telephone:
 (800) 361-5265
 Monday to Friday 7:30am to 9:00pm EST
 D-Link Technical Support over the Internet:
 http://support.dlink.ca
 email:support@dlink.ca

When contacting technical support, please provide the following information:
 ·  Serial number of the unit
 ·  Model number or product name
 ·  Software type and version number

Contacting Technical Support
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Warranty 
Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited 
warranty for its product only to the person or entity that originally purchased the product from:

· D-Link or its authorized reseller or distributor and
· Products purchased and delivered within the fifty states of the United States, the District of 
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or 
FPO. 

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described below 
will be free from material defects in workmanship and materials from the date of original retail purchase 
of the product, for the period set forth below applicable to the product type (“Warranty Period”), except 
as otherwise stated herein. 

1-Year Limited Warranty for the Product(s) is defined as follows:

· Hardware (excluding power supplies and fans) One (1) Year
· Power Supplies and Fans One (1) Year
· Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period 
at no charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement 
will be rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not 
be new or have an identical make, model or part.  D-Link may in its sole discretion replace the defective 
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is 
substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or 
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date 
of original retail purchase.  If a material defect is incapable of correction, or if D-Link determines in its 
sole discretion that it is not practical to repair or replace the defective Hardware, the price paid by the 
original purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the 
defective Hardware.  All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase 
price is refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will 
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the 
applicable documentation, from the date of original retail purchase of the Software for a period of ninety 
(90) days (“Warranty Period”), provided that the Software is properly installed on approved hardware 
and operated as contemplated in its documentation. D-Link further warrants that, during the Warranty 
Period, the magnetic media on which D-Link delivers the Software will be free of physical defects.  D-
Link’s sole obligation shall be to replace the non-conforming Software (or defective media) with software 
that substantially conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s 
sole discretion.  Except as otherwise agreed by D-Link in writing, the replacement Software is provided 
only to the original licensee, and is subject to the terms and conditions of the license granted by D-Link 
for the Software.  Software will be warranted for the remainder of the original Warranty Period from the 
date or original retail purchase.  If a material non-conformance is incapable of correction, or if D-Link 
determines in its sole discretion that it is not practical to replace the non-conforming Software, the price 
paid by the original licensee for the non-conforming Software will be refunded by D-Link; provided that 
the non-conforming Software (and all copies thereof) is first returned to D-Link.  The license granted 
respecting any Software for which a refund is given automatically terminates.

Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software 
of D-Link’s products will not be applied to and does not cover any refurbished product and any product 
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purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, 
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, 
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited 
Warranty as described herein, notwithstanding anything stated herein to the contrary.  

Submitting A Claim:  The customer shall return the product to the original purchase point based on 
its return policy.  In case the return policy period has expired and the product is within warranty, the 
customer shall submit a claim to D-Link as outlined below:

· The customer must submit with the product as part of the claim a written description of the 
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same. 
· The original product owner must obtain a Return Material Authorization (“RMA”) number from 
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of the product 
(such as a copy of the dated purchase invoice for the product) before the warranty service is provided.
· After an RMA number is issued, the defective product must be packaged securely in the original 
or other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number 
must be prominently marked on the outside of the package.  Do not include any manuals or accessories 
in the shipping package.  D-Link will only replace the defective portion of the Product and will not ship 
back any accessories.
· The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery 
(“COD”) is allowed.  Products sent COD will either be rejected by D-Link or become the property of D-Link.  
Products shall be fully insured by the customer. D-Link will not be held responsible for any packages that 
are lost in transit to D-Link.  The repaired or replaced packages will be shipped to the customer via UPS 
Ground or any common carrier selected by D-Link, with shipping charges prepaid. Expedited shipping 
is available if shipping charges are prepaid by the customer and upon request.

· Return Merchandise Ship-To Address
USA: 17595 Mt. Herrmann, Fountain Valley, CA 92708
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed warranty 
information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the 
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The 
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product 
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined 
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s 
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, 
misuse, faulty installation, lack of reasonable care, repair or service in any way that is not contemplated 
in the documentation for the product, or if the model or serial number has been altered, tampered with, 
defaced or removed; Initial installation, installation and removal of the product for repair, and shipping 
costs; Operational adjustments covered in the operating manual for the product, and normal maintenance; 
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;  
Any hardware, software, firmware or other products or services provided  by anyone other than D-Link; 
Products that have been purchased from inventory clearance or liquidation sales or other sales in which 
D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the product.  
Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, 
THE PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER 
INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE 
DISCLAIMED IN ANY TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED 

Warranty 
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WARRANTY SHALL BE LIMITED TO NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER 
THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION 
AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE 
UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE 
THEORY FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY 
CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, 
BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, 
WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT 
OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED WITH, LOSS OF 
INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT 
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE 
PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THIS 
LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS 
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  
THE MAXIMUM  LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE 
PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN 
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES 
OR REMEDIES, EXPRESS, IMPLIED OR STATUTORY.

Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some 
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how 
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited 
warranty provides specific legal rights and the product owner may also have other rights which vary 
from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered 
trademarks are the property of their respective manufacturers or owners. 

Copyright Statement:  No part of this publication or documentation accompanying this Product may 
be reproduced in any form or by any means or used to make any derivative such as translation, 
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., 
as stipulated by the United States Copyright Act of 1976.  Contents are subject to change without 
prior notice.  Copyright© 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio 
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communication. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more 
of the following measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the receiver is  
  connected.
· Consult the dealer or an experienced radio/TV technician for help.

Warranty
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For detailed warranty outside the United States, please contact corresponding local D-Link office. 

FCC Caution: 
The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications 
to this equipment; such modifications could void the user’s authority to operate the equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this device 
to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

IMPORTANT NOTE:  
FCC Radiation Exposure Statement: 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.  
The antenna(s) used for this equipment must be installed to provide a separation distance of at least 
eight inches (20 cm) from all persons. 
This equipment must not be operated in conjunction with any other antenna.

Warranty 
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Registration 

Registration 

Version 1.2
Revised: 1/17/2006

Product registration is entirely voluntary and failure to complete or return 
this form will not diminish your warranty rights.


